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Introduction
This Release Notes document summarizes the features, enhancements, and updates delivered with 
the FlexNet Operations 2022 R1 On Premises release. The document includes the following 
information:

• Resources

• Features and Enhancements

• System Requirements

• Resolved Issues

• Known Issues

• Special Notes

• Legal Information

Resources
These resources are available for more information about FlexNet Operations and other Revenera 
products:

• Revenera Resources

• FlexNet Operations Videos

Revenera Resources
The following resources can help you stay up to date with FlexNet Operations news and product 
knowledge:

• In addition to providing case management, the Revenera Community site can help you quickly find 
answers to your questions by searching content from other customers, product experts, and 
thought leaders. You can also post questions on discussion forums for experts to answer. For 
each of Revenera’s product solutions, you can access forums, blog posts, and knowledge base 
articles. You can also access the Product and License Center from the Community’s Other 
Resources menu to download Revenera products.

• You can find documentation for FlexNet Operations and all other Revenera products on the 
Revenera Product Documentation site.

• The Revenera Learning Center offers free, self-guided, online videos to help you quickly get the 
most out of your Revenera products. You can find a complete list of these training videos in the 
Learning Center. 

• Customers who have purchased a maintenance contract for their product(s) can submit a support 
case or check the status of an existing case by making selections on the Get Support menu of the 
Revenera Community:

https://community.revenera.com

https://community.revenera.com
https://docs.revenera.com
https://learning.revenera.com
https://community.revenera.com


FlexNet Operations 2022 R1 On Premises Release Notes  (July 2022) Company Confidential 3

FlexNet Operations Videos
These brief, informative videos walk you through the getting-started exercises found in the FlexNet 
Operations User Guide (online help or PDF version). We recommend that you first read the appropriate 
“Getting Started” section in the User Guide to gain an understanding of the concepts it covers, and 
then click the section title in the table below to view the video.  

Features and Enhancements
Features and enhancements were added to the following areas of FlexNet Operations On Premises in 
the 2022 R1 release: 

• Device Management Enhancements

• Entitlement Management Enhancements

• License Management Enhancements

• Download Package Management Enhancements

Device Management Enhancements
This section describes the enhancements introduced in 2022 R1 for managing devices.

Guide Topics

Getting Started with 
Entitlement Management

Creating an account, a user, a product, and an entitlement. 

Getting Started with FlexNet 
Embedded Licensing

Setting up a publisher, identity, and a licensed product. Creating 
a device and activating its license. Creating and provisioning 
FlexNet Embedded license servers. 

Getting Started with 
Electronic Software Delivery

Creating a producer and download packages, associating 
download packages with a product, creating files, associating 
files with download packages, and viewing and downloading files 
from the FlexNet Operations End-User Portal. 

Getting Started with Usage 
Management

Creating a usage-based license model, a feature, a product, and 
an entitlement. Obtaining the license server URL to which the 
usage data is sent. Running a usage-capture client. Viewing 
usage information graphs and gauges.

Getting Started with FlexNet 
Publisher License File-
Based Licensing

Activating and returning a certificate license.

Getting Started with Cloud 
Licensing Service

Creating a cloud-hosted license server. 

Getting Started with FlexNet 
Customer Growth

Customer growth concepts and configuring notifications for 
expiring entitlements and expired entitlements. 

https://youtu.be/L_DJynsiCRs
https://youtu.be/6-juN9F9OBo
https://www.youtube.com/watch?v=VGnH8dFj_bE
https://youtu.be/1rPRl-NKgJY
https://youtu.be/-OHqqD62fyk
https://www.youtube.com/watch?v=MNX5bgFHPVg
https://youtu.be/u0oCCN-iXJU
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• Return of a FlexNet Embedded Device with Expired/Inactivated Licenses Now Allowed

• Device ID Now Hyperlinked

• Ability to Modify Metered License Counts on Cloud License Servers

Return of a FlexNet Embedded Device with Expired/Inactivated Licenses 
Now Allowed
Currently, a user in the Producer Portal or End-User Portal is not allowed to return a FlexNet Embedded 
device (license server or standalone device) if one or more of its licenses are expired or inactive and 
the return process is configured to transfer the device’s licenses to another device. When the user 
attempts to initiate the device return, the following message is displayed: “Either the feature limit has 
been exceeded or its license has expired, or the feature is not allowed at all on the host.” 

However, some customers might want the ability to return a FlexNet Embedded device even though 
one or more of its licenses are expired or inactive. In this release, a customer can now request to have 
this behavior enabled. If enabled, the return process would be as follows:

• If some of the licenses are expired or inactive, the device is returned, and only those licenses that 
are active are transferred to the destination device. Any expired or inactive licenses are returned 
to the appropriate entitlement line-item counts in FlexNet Operations. 

• If all the device’s licenses are expired or inactive, the device is returned, but no licenses are added 
to the destination device and instead are returned to the appropriate entitlement line-item counts. 

If you require this modified behavior, set skip.expired.line.items to true.

Device ID Now Hyperlinked
Previously, a device’s Name value on the Devices page list was hyperlinked to the Device Details page. 
Now, a device’s ID value in the list on this page is also hyperlinked to the Device Details page. This 
enhancement enables producers to hide the Device Name (for security purposes, for example) while 
still providing users access to the Device Details page through the ID hyperlink.  

Ability to Modify Metered License Counts on Cloud License Servers
In this release, it is now possible to change the counts of metered licenses mapped to Cloud license 
servers. This enhancement enables producers and end customers to increase, decrease, or completely 
remove the number of licenses mapped to a license server, within the count of licenses specified in an 
entitlement line item.

This feature is available through the UI only, not through Web Services.  

Note • It is not possible to modify counts of metered licenses mapped to local license servers. 

Entitlement Management Enhancements
This section describes the enhancements introduced in 2022 R1 for managing entitlements.
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Licenses Associated with Inactive or Obsolete Line Items Automatically 
Removed from CLS Instances
When the state of an entitlement line item is changed to inactive or obsolete, any unused concurrent or 
metered licenses associated with the line item can now be automatically removed from those CLS 
instances to which the line item is mapped. Any currently in-use licenses associated with the line item 
are automatically removed from the CLS instances once users return them. 

The automatic removal of licenses occurs when the line item is made inactive or obsolete using a 
setLineItemState or setEntitlementState SOAP request. 

This feature requires that the configuration option Remove licenses from CLS when line item state is 
changed to Inactive/Obsolete be selected and that Allow used entitlement/line item state change to 
Inactive or Obsolete be unselected. (Both options are found under System > Configuration > FlexNet 
Operations > General Options in the Producer Portal.) 

License Management Enhancements
This section describes the 2022 R1 enhancements to license management and models.

New Configuration Option to Batch-Rehost All Fulfillments
Currently, during a Batch Rehost process, if a producer selects to rehost fulfillments from more than 
10 line items belonging to the same entitlement, a maximum of 10 fulfillments is rehosted. This limit 
can cause an issue when a producer wants to rehost all fulfillments on a given host and the host is 
activated with an entitlement that has more than 10 line items. 

The following configuration option has been added in this release to enable a producer to rehost all 
available fulfillments for an entitlement during a Batch Rehost. (The 10-fulfillment limit is not 
exercised.)

System > Configure > FlexNet Operations > General Options > Process all line items in an 
Entitlement during Batch Rehost

This option applies to FlexNet Publisher fulfillments only.  

Download Package Management Enhancements
The following enhancements to the management of download packages were added in the 2022 R1 
release.

• Geographic Restrictions for Downloading Packages

• Download Package Selection Across Pages in the End-User Portal

• Custom Activation ID Attribute for Entitlement Line Items Now Displayable on Download Order 
Page

Geographic Restrictions for Downloading Packages
Producers can now restrict access to packages for file downloads to certain countries, and optionally 
to regions in those countries. This feature helps ensure that software approved for a specific location 
(country or country/region) can be downloaded by accounts only in that location. 
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The Restrict Download Package page (accessed from the View Download Package page in the 
Producer Portal) now enables producers to add countries or specific regions in countries to which the 
download package will be available. In the End-User Portal, only users in those accounts assigned to 
these geographic locations will have access to the download package, even if the accounts are 
otherwise entitled to the download.

Producers can select all countries with a single click when configuring geographic restrictions for a 
download package. This option is especially helpful when the list of countries is long. Producer users 
can quickly select all countries (and then optionally unselect the few that should not included.)  

Note the following about geographic restrictions:

• The geographic restrictions are in addition to the existing Grant or Deny Account Access 
restrictions available on the Restrict Download Package page. Accounts must meet both sets of 
restrictions in order to access the download package.

• If you set up geographical restrictions and sell through Channel Partners, you must include a 
Channel Partner's country and region in the geographical restriction list of countries and regions 
for a download package.  

Download Package Selection Across Pages in the End-User Portal
In the previous release, users in the End-User Portal could select packages to download from only the 
current page in the Download Packages window; package selections on other pages were not 
processed during the download. If users wanted to download packages listed on other pages, they 
were forced to perform downloads one page at time.

In this release, users can now download packages selected across pages. The following mechanisms 
were added to support this feature.

Package Selection on a Given Page

To initiate the download process, select the View > View Download Packages option on the List 
Entitlements page. This option opens the Download Packages window, where you can view a list of 
the software download packages available for the selected line items and then download selected (or 
all) packages. 

In the grid that lists the download packages for a specific page, a tool tip is now displayed when you 
hover over the “check box” column in the grid header, stating “Click to select all items on this page”.

Package Selection Across Pages

The following mechanisms are introduced to help in the selection of packages across pages.

• As you select packages across individual pages, a message above the grid updates to the number 
of currently selected packages out of the total number of all available packages (across all pages). 
The message also provides the option to select all the available packages.

• If you click Select all n items available to select all packages, all packages (and files in those 
packages) are selected on every page. However, once you click this option, you cannot unselect 
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specific packages or files within those packages. To make individual selections, you must click the 
Clear Selection toggle and reselect specific packages (and specific files in those packages).

Download Validation

When you click Download to start the package download process, the packages are first validated. The 
following new mechanisms assist in managing the package validation phase of the download, 
especially when multiple packages have been selected across pages.

• If any packages fail validation, the following error message is now displayed.

• You can click review and resolve in the message to open the Failed Packages window, listing the 
packages that failed validation. If an action is available to remediate the validation error for a 
listed package (for example, agree to an EULA that had not yet been accepted), you can perform 
that action directly from the window. If no action is available, you can choose to remove the 
package from the download process. The option to cancel the entire download process is also 
available.  

Custom Activation ID Attribute for Entitlement Line Items Now Displayable 
on Download Order Page
Existing functionality has enabled producers to create a custom attribute for entitlement line items 
and use this attribute in place of the Activation ID (by hiding the default Activation ID attribute) on the 
List Entitlements window in the End-User Portal. However, producers were not able to make a similar 
replacement on the Download Order window (which is displayed when the user clicks Download Now 
for a line item on the List Entitlements window).  
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In this release, FlexNet Operations can now automatically replace the Activation ID property on the 
Download Order page with the custom activation ID attribute (such as used on the List Entitlements 
window). To accomplish this, an administrator sets the following new configuration option with the 
name of the custom activation ID attribute:

System > Configure > End-User Portal Setup > DownloadOrderPage > Show Custom Activation ID 
<custom_attribute_name>  

The custom activation ID attribute now shown on the Download Order window is automatically 
populated with the value assigned to the entitlement line item corresponding to the order. Refer to the 
following table for exceptions to this behavior:

Value of custom activation ID 
attribute for a given entitlement 
line item

Custom attribute is/is not 
designated for “Show Custom 
Activation ID”

Activation ID item displayed 
on Download Order window 
for line item 

Any <value> other than “Not 
Applicable” and “Not Required”

Designated The custom activation ID 
attribute with the value 
<value>. This replaces the 
Activation ID property and its 
value.

“Not Required” Designated The custom activation ID 
attribute with the “Not 
Required” value. This replaces 
the Activation ID property and 
its value.

“Not Applicable” Designated The Activation ID property. 
and its value.

No value Designated The Activation ID property and 
its value.

Any <value> or no value Not designated The Activation ID property and 
its value.
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System Requirements
Detailed system requirements for FlexNet Operations 2022 R1 On Premises include the following.

Requirement Description

Supported Operating 
Systems

• Microsoft Windows Server 2022 

• Microsoft Windows Server 2019 

• Microsoft Windows Server 2016 

• Red Hat Enterprise Linux 8.4 (64-bit)

• Virtual appliance: Linux (64-bit) based on CentOS-7

Important • All Linux platforms must be Linux Standard Base (LSB) 
compliant.

Supported databases • SQL Server 2019

• SQL Server 2017
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Servers

Note • For best performance, availability, and reliability, install each 
FlexNet Operations component on a separate host.

For Windows servers (each)

• Dual core

• 8 GB of RAM for each component (FlexNet Operations, Cloud 
Licensing Service, Usage Analytics Service) 

• Minimum of 10 GB free disk space 

For Linux servers (each)

• Dual core 

• 8 GB of RAM for each component (FlexNet Operations, Cloud 
Licensing Service, Usage Analytics Service) 

• Minimum of 10 GB free disk space 

• Current directory (.) must be in the path of the user who starts the 
FlexNet Operations server 

For Virtual Appliance

• 8 GB of virtual RAM

• 8 GB of virtual disk space

• VMware requires about three times as much hard disk space at Open 
Virtualization Format package deployment time

Application server WildFly version 8.2.0, with default configured heap space minimum of 4 
GB and maximum of 8 GB 

Message broker 
software

RabbitMQ version 3.10.6 (with Erlang/OTP v13.0.2 (25))

Supported Java 
development kits

• Oracle JDK 1.8

• OpenJDK 1.8

Supported web 
browsers 

• Microsoft Edge 

• Mozilla Firefox 101.x 

• Google Chrome 102.x 

Requirement Description
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Resolved Issues
Issues in the following areas were resolved in the 2022 R1 release:

• Account and User Management Issues Resolved

• Security Issues Resolved

• Entitlement Management Issues Resolved

• Electronic Software Delivery Issues Resolved

• Device Management Issues Resolved

• License Management Issues Resolved

Supported FlexNet 
licensing modules 

• FlexNet Publisher Toolkit 11.16.1.0 or later

• FlexNet Embedded Toolkit 2015 R2

Note • FlexNet Operations On Premises supports these FlexNet 
Embedded host ID types: ETHERNET, INTERNET, INTERNET_6, FLEXID9, 
FLEXID10, STRING, USER, VM_UUID, EXTENDED, PUBLISHER_DEFINED, 
and CONTAINER_ID.

Supported vendor 
certificate generators 

The current versions of the VCG kit are 12.11.0 and 16.2.2.0. 

These VCGs were tested with the following compilers: 

• Windows—Visual Studio 2010 Professional Edition 

• Linux—gcc 4.1.2 (RHEL 5.0) 

• Linux—gcc 4.4.4 (RHEL 6.0) 

Note • The 12.11.0 VCG is built with FlexNet Publisher 11.11.1 and 
shares the same minimum C compiler requirements on each supported 
platform. (See the FlexNet Publisher 11.11.1 release notes for C/C++ 
compiler support.) 

Supported upgrade 
paths

You can upgrade from the following previous FlexNet Operations versions 
to the current version:

• 2020 R1.1

• 2021 R1 

Supported LDAP 
directory servers 

Windows 2012 Active Directory 

Requirement Description
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• Export and Import Issues Resolved

• SOAP and REST Web Services Issues Resolved

• Download Package Management Issues Resolved

• Email Notification System Issues Resolved

• Product Management Issues Resolved

Account and User Management Issues Resolved
The following issue was resolved for the management of accounts and users in the 2022 R1 release.

Advanced Search of Accounts by Custom Attributes No Longer Failing 
During Bulk Upgrade Setup
In the previous release, during the configuration of an entitlement Bulk Upgrade or Bulk Renewal 
operation, attempts to use a custom attribute as a criterion to perform an Advanced Search on 
accounts would fail with an application error. This issue is now fixed so that using a custom attribute 
to search accounts no longer fails during the Bulk Upgrade or Bulk Renewal setup.  

Security Issues Resolved
The following security issues have been resolved in this release.

• Clear Text Password No Longer Exposed

• Configuration Added for Re-Validating Users Before Sending Entitlement Emails

• Configuration Added for Locking Out Users after Successive Attempts to Reset Password

Clear Text Password No Longer Exposed
A potential information leakage issue has been addressed, where an encrypted password was 
identified as part of the HTML source of the Create License Technology page. 

As a result of the fix, the “test connection” action on the page can now be performed only upon saving 
the changes when creating and updating the license technology.

If a user attempts to test the connection before saving their changes, an error message is displayed 
which prompts the user to save their changes to the license technology before continuing. 

Configuration Added for Re-Validating Users Before Sending Entitlement 
Emails
A new configuration option Use Recaptcha validation when sending entitlement emails has been 
introduced to enable the Google ReCAPTCHA validation mechanism when sending entitlement emails. 
The option is located under System > Configure > FlexNet Operations > General Options. 

If selected, entitlement emails will only be sent after re-authentication using the Google reCAPTCHA 
mechanism. 
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This option works in conjunction with the following existing options for setting the site key and 
reCAPTCHA password:

• System > Configure > FlexNet Platform Server > General Options > Recaptcha Site key

• System > Configure > FlexNet Platform Server > General Options > Recaptcha Secret password

If selected, the List Entitlements email preview page of the Producer Portal shows the “I’m not a 
robot” check box which enables the user to send an entitlement email.

By default, this option is unselected. 

Configuration Added for Locking Out Users after Successive Attempts to 
Reset Password
The following configuration parameters are now available to enable FlexNet Operations to lock out 
users after a succession of invalid attempts to reset their password:

• System > Configure > Validators > Lock out user upon repeated password reset attempts—The 
option that, when enabled, locks out a user for a set amount of time after successive failed 
password-reset attempts. (The number of consecutive failed attempts is defined as part of the 
existing FlexNet Platform Server configuration, as described below.)

• System > Configure > Validators > Lockout period after failed reset attempts—The number of 
minutes a user is locked out before allowed to reset password again. The lockout period begins 
immediately after the user’s last password-reset attempt. 

These parameters work in conjunction with the following existing parameter, which sets the limit on 
the number of consecutive password-reset attempts allowed before a user is locked out.

System > Configure > FlexNet Platform Server > General Options > Consecutive Failed 
Authentications

This added functionality is part of an ongoing effort to improve overall FlexNet Operations security.  

Entitlement Management Issues Resolved
The following issues were resolved for entitlement management in the 2022 R1 release.

• Resolved Time Zone Issue in Entitlement Search

• Resolved Issue with Entitlement Line Item Creation for Self-Registered Users

• Incorrect Date Conversion for Custom Attributes

• Line Item’s Last Modified Time No Longer Fails to Update

• Advanced Search of Accounts by Custom Attributes No Longer Failing During Bulk Upgrade Setup

• Removal/Unlinking Older Maintenance Line Items from an Entitlement Line Now Possible

• Disparity Between Mapped License Quantities for the Same “Last Modified” Date

• Issue with Mapping Over 2100 Activation IDs Addressed

• All Lines for New Entitlement Now Listed Whether or Not They Define Values for New Custom 
Attributes
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• Information in New Product or Entitlement No Longer Overwriting Information in Other Opened 
Products and Entitlements

• Export of All Entitlements From End-User Portal Now Successful

• “Email Template variation” Field No Longer Resetting Itself During Entitlement Creation

• Attempts to Transfer an Entitlement Count Back to Its Original Entitlement No Longer Failing

• New Checks in Place to Prevent Concurrent Transfer and Mapping Operations Against the Same 
Entitlement Line Item

• Changes to Line Items Now Shown on License Server

Resolved Time Zone Issue in Entitlement Search 
When performing an advanced search on entitlement counts in the FlexNet Operations Producer 
Portal, the local time zone of the user performing the search is taken into consideration. However, in 
the previous release, this was different when an entitlement search was performed using Web 
Services, where the user’s local time zone was not considered. As a result, entitlement search result 
would differ depending on the search method.

To produce search results that are consistent with those reported through the Producer Portal, 
customers using Web Services can now use the search parameter lastModifiedDate. This ensures 
that the user’s time zone is taken into consideration.

Resolved Issue with Entitlement Line Item Creation for Self-Registered 
Users
Previously, a stack overflow error could be observed when an entitlement line item was created and if 
the entitlement was associated with a self-registered user. This has now been resolved.  

Incorrect Date Conversion for Custom Attributes
An issue could be observed in the FlexNet Operations Producer Portal where custom attributes of type 
date were converted incorrectly to an earlier date upon saving the associated entitlement or product. 
This issue only occurred in deployments hosted in AWS. 

This has now been resolved. 

Line Item’s Last Modified Time No Longer Fails to Update
In the previous release, when a license was removed from a device, the corresponding line item's last 
modified time was not updated. This issue no longer occurs. 

Removal/Unlinking Older Maintenance Line Items from an Entitlement Line 
Now Possible
Previously, when multiple maintenance line items were linked to a single entitlement line, removing 
older maintenance line items was not possible without removing the more recent maintenance line 
items. This issue has now been fixed. Older maintenance line items can be removed/unlinked from the 
entitlement line.  
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Disparity Between Mapped License Quantities for the Same “Last Modified” 
Date
Previously, when users mapped licenses to a device, the last modified timestamp on a line item was 
updated before the update to the mapped-license quantity was applied. As a result, customers who 
pulled data from FlexNet Operations (for example, using the getActivatableItemsQuery SOAP method) 
before the mapped-license quantity was updated would see a stale quantity value corresponding to 
the last modified date in the response. However, users would then observe the correct mapped-
license quantity for that same date in the FlexNet Operations portals. 

Now the last modified time on the line item is updated after the change to the mapped license 
quantity.  

Issue with Mapping Over 2100 Activation IDs Addressed
In the previous release, attempts to map more than about 2,100 activation IDs at once to a device 
would result in an error. This error has now been fixed so that such mappings should complete 
successfully.

However, users should still apply caution when mapping extremely large numbers of activation IDs in 
one step. If the number of activation IDs is large, processing can be very slow; and, if the number of IDs 
is large enough, a timeout can still occur.

Hence, the general recommendation is not to map extremely large numbers of activation IDs in one 
step. Use an alternate process instead.  

All Lines for New Entitlement Now Listed Whether or Not They Define Values 
for New Custom Attributes
In the previous release, when a new custom attribute was configured to display as a column on the 
List Entitlements page in the Producer and End-User portals, an issue could occur when new line 
items were added to an entitlement. Only those new line items that defined a value for the attribute 
were displayed on the List Entitlements page and in line-item lists on other pages in both portals. New 
line items that left the attribute blank were not listed.

This issue is now resolved so that all new line items for an entitlement are displayed, whether or not 
the custom attribute for a given line item has been set. (A prerequisite for this fix is that the custom 
attribute must allow only text, date, or number values.) 

Note that, to ensure that existing entitlement line items are visible once a new custom attribute is 
enabled, users need to do either of the following:

• Make sure the custom attribute for each existing line item has a value set.

• For those line items that have a null value for the custom attribute, programmatically update the 
attribute with a dummy value, such as “N/A”.  
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Information in New Product or Entitlement No Longer Overwriting 
Information in Other Opened Products and Entitlements
In the previous release, when a producer created and saved a new product or entitlement while an 
existing product or entitlement was currently open in the same browser session, the information in the 
new product or entitlement could overwrite information in the corresponding existing entity (as seen 
when the existing entity was refreshed). The same problem was seen on Bulk Entitlement, Test 
Entitlement, and Test Bulk Entitlement pages. This issue has now been resolved.  

Export of All Entitlements From End-User Portal Now Successful
An attempt by a producer user to export all entitlements from the End-User Portal was failing in 
previous releases. This issue should no longer occur.  

“Email Template variation” Field No Longer Resetting Itself During 
Entitlement Creation
Email Template variation field is no longer resetting itself back to the default Select value whenever 
users attempt to add channel partners during the entitlement creation process.  

Attempts to Transfer an Entitlement Count Back to Its Original Entitlement 
No Longer Failing
In the previous release, an attempt to transfer a license count for an entitlement line item under 
certain conditions could fail with the following error message: “The number of copies cannot be set to 
a number less than the fulfilled amount n.” The error was occurring (both in the Producer and End-User 
portals and for the transferLineItem Web Services method) even though the count being transferred 
was currently not fulfilled or mapped to any device. This issue is now resolved.  

New Checks in Place to Prevent Concurrent Transfer and Mapping 
Operations Against the Same Entitlement Line Item
In the previous release, users were allowed to run a license-mapping operation against an entitlement 
line item while a license transfer was currently in progress against this same line item. The concurrent 
operations could result in corrupted license counts.

Now, during the transfer of an entitlement line to a different account or entitlement (through either the 
Producer or End-User Portal or the transferLineItems SOAP request), users are prohibited from 
mapping/unmapping licenses from the line item to/from a device. 

If users attempt to perform a mapping operation during a license transfer that involves the same line 
item, the following message is displayed in the UI: “A license transfer is in progress for the activation 
Id <activationId>. Please wait until this has completed.” Additionally, the line item currently being 
transferred will be unavailable for mapping operations until the transfer is completed.  

Changes to Line Items Now Shown on License Server
Previously, in some cases when a line item was updated (for example, to extend an expiration date), 
the changes to the line item were not displaying on the relevant license server. The situations that 
caused this issue have now been resolved.  
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Electronic Software Delivery Issues Resolved
The following issues were resolved for Electronic Software Delivery (ESD) in the 2022 R1 release.

• Data Import Template Functionality Now Applies Maintenance Expiration Date to ESD Entitlements

• Unwanted Text String No Longer Showing in License Agreement Content

• “Extended Description” Field on “Add File” Page Returned to Its Previous Maximum Length

Data Import Template Functionality Now Applies Maintenance Expiration 
Date to ESD Entitlements
Previously, when a maintenance line item was linked to an ESD entitlement line item, the maintenance 
expiration date was not updated to the entitlement line item. This issue no longer occurs.

For more information about the visibility of download packages based on the maintenance line 
expiration, see the following topic in the “Getting Started with Electronic Software Delivery” section of 
the FlexNet Operations User Guide:

https://docs.revenera.com/fno2021r1_onprem/producer/Content/helplibrary/
opsGS_ESD_SetupAdvTopics.htm

Unwanted Text String No Longer Showing in License Agreement Content
In the previous release, the following string could be included in the End User License Agreement 
(EULA) contents displayed on the License Terms and Conditions page for a given download package in 
the End-User Portal:

???EULAServlet.ExportCompliance.DefaultContent???

The unwanted string is no longer displayed. 

“Extended Description” Field on “Add File” Page Returned to Its Previous 
Maximum Length
An issue was reported that the maximum size for the Extended Description field on the Add File page 
had changed from 1000 to 2000 characters. In this release, the size discrepancy has been resolved: 
the field’s previous 1000-character maximum size has been restored.

Device Management Issues Resolved
The following issues were resolved for the management of devices in the 2022 R1 release.

• Devices with Names Containing HTML-like Characters Now Handled Properly

• Details for Served Devices Now Visible to Partners

Devices with Names Containing HTML-like Characters Now Handled 
Properly
When a device was created using characters in its name that could be confused with HTML tags, the 
Device Details page sometimes rendered the device name incorrectly. This issue has been fixed so 
that the device name is rendered correctly with all valid device name characters.  

https://docs.revenera.com/fno_CURRENT/producer/Content/helplibrary/opsGS_ESD_SetupAdvTopics.htm#fno_gs_esd_3336344908_1116758
https://docs.revenera.com/fno_CURRENT/producer/Content/helplibrary/opsGS_ESD_SetupAdvTopics.htm#fno_gs_esd_3336344908_1116758
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Details for Served Devices Now Visible to Partners
Partner users in the End-User Portal (or using SOAP web services) are now able to view the details of a 
device whose features are served by a license server belonging to a customer account associated with 
the partner. This capability exists as long as the license server is licensed with an activation ID that is 
mapped to both the partner’s account and the customer’s account. Previously, partners could not view 
served-device details in an associated customer account. 

License Management Issues Resolved
The following issue involving license management has been resolved in the 2022 R1 release.

Concurrent License Requests Now Handled Properly on CLS Instances
In the previous release, concurrent license updates for a Cloud License Server (CLS) instance could 
result in the failure of one of the requests, thus leading to a count mismatch between the FlexNet 
Operations UI and the CLS REST endpoint output. This issue has been resolved so that concurrent 
requests are handled properly without leading to any count mismatch.  

Export and Import Issues Resolved
The following issues related to the Data Export and Import functionality was resolved in the 2022 R1 
release.

• Unrestricted Data Upload for an Import Now Addressed

• Links Between License Models and Part Numbers Retained During Product Updates with Template

Unrestricted Data Upload for an Import Now Addressed
Previously, FlexNet Operations would allow almost any file type to be uploaded from the Import Data 
Objects window, including file types not supported by the import. Although FlexNet Operations would 
throw an error for the unsupported file type when the actual import of the uploaded file was 
attempted, the fact that any file could be uploaded to a web root folder was a security issue. 

To address this issue, FlexNet Operations now shows only supported file types (Unicode text and 
executable jar) for an import at the time the user selects the file from the Import Data Objects window. 
If the selected file type is unsupported for the type of upload requested, an error is thrown, telling the 
user to select a file type corresponding to the upload type.   

Links Between License Models and Part Numbers Retained During Product 
Updates with Template
Updating products using the CreateUpdateProduct template is no longer removing the links between 
part numbers and license models.  

SOAP and REST Web Services Issues Resolved
The following issues related to FlexNet Operations Web Services were addressed in the 2022 R1 
release:
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• “generateCapabilityResponse” Method Now Properly Acknowledging Inactive or Obsolete 
Entitlement Line Items

• “getEntitlementLineItemPropertiesQuery” with “restrictToItemsWithCount” Filter Now Returning 
Correct Items

• “getAccountsCount” SOAP web service (UserAcctHierarchySerice v3) Now Returning Correct 
Totals

• Replace Operation in updateProduct Now Properly Replacing License Model

• Integration Issues with Versioned SOAP Web Services Resolved

“generateCapabilityResponse” Method Now Properly Acknowledging 
Inactive or Obsolete Entitlement Line Items
In the previous release, the generateCapabilityResponse method (in the ManageDeviceService SOAP 
web service) would return a SUCCESS status in the capability response even though one or more of the 
requested line items were obsolete or inactive. While the obsolete or inactive line items were not 
mapped to the device as expected, the resulting SUCCESS status was misleading.

Now, the generated capability response shows a PARTIALFAILURE status when one or more of the 
requested line items are obsolete or inactive. The <reason> element in the response indicates which 
licenses could not have their copies increased (in this case, due to their obsolete or inactive status).  

“getEntitlementLineItemPropertiesQuery” with “restrictToItemsWithCount” 
Filter Now Returning Correct Items
A getEntitlementLineItemPropertiesQuery request in which the restrictToItemsWithCount filter is set 
to true now correctly returns only those activation IDs whose counts are greater than 0. Previously, the 
response included activation IDs with 0 counts. (The getEntitlementLineItemPropertiesQueryRequest 
method belongs to the EntitlementOrderService SOAP web service.)  

“getAccountsCount” SOAP web service (UserAcctHierarchySerice v3) Now 
Returning Correct Totals
The getAccountsCount SOAP web service (version 3 of UserAcctHierarchyService) now returns correct 
totals when multiple account types are specified in the request.  

Replace Operation in updateProduct Now Properly Replacing License Model
The REPLACE operation for opType in the updateProduct method (in the ProductPackagingService 
SOAP web service) now properly replaces a license model for a product. Previously, the operation was 
adding a license model to the product instead of replacing one.  

Integration Issues with Versioned SOAP Web Services Resolved
Previous releases experienced a Web Services problem in which a "/" in the service binding name (for 
example, v4/EntitlementOrderService) could result in an error and failed integration. The error 
occurred on certain integration platforms and libraries such as Tibco BW, Windows Communication 
Foundation and .Net Core.

To resolve this issue, new versions of the EntitlementOrderService and UserAcctHierarchyService web 
services have been introduced. Both use a binding name format that omits the “/”:
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• EntitlementOrderService (v5)

• UserAcctHierarchyService (v4)  

Download Package Management Issues Resolved
The following issues were resolved for the management of download packages in the 2022 R1 
release:

• Updates to the Failed Packages Window

• Multiple-Package Download No Longer Failing When Some Packages Contain No Files

• Proper Behavior on “Failed Download Packages” Window After All Failed Packages Are Cleared

• “I agree” Option to Resolve Unaccepted EULAs Now Working Properly

• Reports of Download Progress Greater than 100 Percent No Longer Occurring

• All Versions of macOS Now Supported by Download Manager

• Correct Linux Path for Logs

Updates to the Failed Packages Window
The Failed Packages window has been updated to provide information about how to handle the 
packages that failed to download due to validation issues during the current download process. (The 
Failed Packages window is opened when you click review and resolve from an error message that is 
displayed on the Download Packages window when certain package selections fail to download.)  

Multiple-Package Download No Longer Failing When Some Packages 
Contain No Files
When an end user downloads multiple packages from the Download Packages window and one or 
some of the selected packages contain no files, the user is now allowed to proceed to download files 
for the remaining download packages. Only when none of the selected packages contain files will an 
error occur and the download process not be allowed to proceed.

Previously, if one or some of the selected packages contained no files, the entire download process 
failed with an error (either on the Download Packages window or the possible subsequent Failed 
Packages window).  

Proper Behavior on “Failed Download Packages” Window After All Failed 
Packages Are Cleared
Once the EULAs have been accepted for all applicable packages listed on the Failed Download 
Packages window, the following behavior now occurs: 

• The window shows the message “No failed packages remaining”, instead of the misleading 
message “No downloads available”.

• When you click Cancel to return to the previous Download Packages window, this window now 
updates properly. It no longer prompts the user to review and resolve failed-package validation 
when no packages are remaining to validate.  
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“I agree” Option to Resolve Unaccepted EULAs Now Working Properly
By design, when you select a package (using the selection column) that contains an unaccepted EULA 
from the Device > Downloads tab, and click Download, the package validation process results in a 
“failed validation” message that includes a review and resolve link. When you click the link, a Failed 
Packages window is displayed, enabling you to accept the EULA (and address any other problems). 
Previously, when you clicked I agree on this window to accept the EULA, the acceptance operation 
would hang. This issue has been fixed so that the I agree option now properly accepts the EULA.  

Reports of Download Progress Greater than 100 Percent No Longer 
Occurring
Download Manager was reporting a progress of greater than 100% for certain files. This problem has 
now been fixed in the latest Download Manager version (1.8) so that file download progress is 
reported correctly. (Users are prompted to install this latest version when they initiate their first 
download in the 2022 R1 release.)  

All Versions of macOS Now Supported by Download Manager
The latest version of Download Manager (1.8) now supports all versions of macOS. It works seamlessly 
on versions prior to macOS 10.15 (for example, 10.14, 10.13, and so forth), on macOS 10.15 
(Catalina), and on latest macOS version, which is 11 (Big Sur).  

Correct Linux Path for Logs
On Linux, Download Manager logs are properly located in the path /var/log/DownloadManager/
log.txt.  

Email Notification System Issues Resolved
The following issue was resolved for the Email Notification system in the 2022 R1 release.

CLS Identification Merge Tags Now Supported in Email Forms in End-User 
Portal
The merge tags [[DEFAULT_GLS_INSTANCE_ID]] and [[DEFAULT_GLS_URL]]—which identify a Cloud 
license server (CLS)—are now supported in the email form used in the End-User Portal to send 
entitlement notifications.  

Product Management Issues Resolved
The following issue involving product management has been resolved in the 2022 R1 release.
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New Product Information No Longer Overwriting Existing Product 
Information
When a producer was creating a product while an existing product was currently open in the same 
browser session, the information saved for the new product could overwrite certain information in the 
existing product (as seen when the existing product was refreshed). This issue is now resolved. 
Information for an opened existing product is no longer overwritten with information from a product 
being created in the same browser session.  

Known Issues
The following describes known issues in the current FlexNet Operations release.

FNO-67482: Users can erroneously access End-User Portal with entitlement 
ID
End-users are able to access the End-User Portal using an entitlement ID, even if the configuration 
option Hide log in “With Entitlement ID” option is selected (in the Producer Portal under System > 
Configure > End-User Portal Setup > Login Page). They can log in by selecting the With Activation ID 
option on the End-User Portal Login page and then entering an entitlement ID in the place of an 
activation ID.

Workaround: Execute the following SQL statement against the FlexNet Operations database to enable 
the required feature flag:

INSERT INTO OPS_FEATURE_FLAG(HIB_VERSION,NAME,SCOPE,ENABLED )
VALUES (1,'portalLogonPageAction.logonEntityTypeValidation','BASE',1);

FNO-67685: Upgrade button for Cloud Licensing Service database 
erroneously enabled
After initializing the database for the Cloud Licensing Service, the Upgrade button on the Manage 
Schema page is enabled even though it should be disabled.

FNO-67509: Upgrade button for FlexNet Usage Management database 
erroneously enabled
After initializing the database for FlexNet Usage Management, the Upgrade button on the Manage 
Schema page is enabled even though it should be disabled.

FNO-67474: “Accounts & Users” Menu in End-User Portal Accessible Via 
URL
A user can access the List all administrators link in the End-User Portal (in the Accounts & Users 
menu) by browsing to a relevant URL with the suffix /flexnet/operationsportal/listAdmins, even if 
their user role has no permissions to view the Accounts & Users menu. 
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SWM-10701: Search functionality in End-User Portal erroneously displays 
download link 
In the End-User Portal, users who should be denied access to a file based on their geographical 
location are able to display the download link for a restricted file when searching for the file name 
(using the Search function with the Files option on the Download Search page). However, users are not 
able to download the restricted file.

FNO-66882: Data Import Template functionality not applying maintenance 
expiration date to ESD entitlements
When Data Import Template functionality is used to link a maintenance line item to an ESD entitlement 
line item, the maintenance expiration date is not automatically applied to the entitlement line. 

Workaround: Reimport the entitlement. This additional step will update the expiration date for the 
entitled Product to reflect the maintenance expiration date.

SWM-6755: Attempts to export all entitlements from End-User Portal 
unsuccessful
An attempt by a producer user to export all entitlements from the End-User Portal can fail.

SWM-8779: Feature names with “SERVER” truncated in trusted storage
Feature names containing the string “SERVER” are truncated when the features are activated in 
trusted storage.

FNO-66018: Errors in UI updated for download package selection across 
multiple pages
In the previous release, the Download Packages window was updated to allow package selection 
across multiple pages. The following errors currently exist for the updated UI.

• Incorrect error message for EULA license on Review & Resolve page

• Search string not properly clearing

• No option to return to full (unfiltered) Download Package list when “failed validation” message 
displays

• Failed validation error displayed for search results

• Pagination control fields not showing correct information

• Inappropriate message displayed for already downloaded packages

Incorrect error message for EULA license on Review & Resolve page

When you attempt to download packages that fail validation, the following message is displayed: 
“Some of the selected packages failed validation. You need to review and resolve the validation 
errors.” Then, on the Failed Packages window that is displayed if you click the “review and resolve” 
link in the message, the error for an unaccepted EULA incorrectly shows the following:

“EULA has not been accepted. To accept EULA, click on the Download package ID.” 
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Instead of “click on the Download Package ID”, the message should instruct the user to “...click ‘I 
Agree’”. 

Search string not properly clearing 

After you filter the package list on the Download Packages window, the message “Results for 
Download package name: <name>” is appropriately displayed. However, if you then click the Clear link 
at the end of message, the search string used to filter the package list remains, the list remains 
filtered (even if you move to the next page), and the “Results for the Download package name...” 
message is still displayed. You must manually delete the search string and click Search to clear the 
filter.

No option to return to full (unfiltered) Download Package list when “failed validation” 
message displays

If the “failed validation” message is displayed after you attempt to download packages from a filtered 
list on the Download Packages window, no mechanism exists to clear the filter to display all packages. 
You must manually delete the search field contents and click Search.

Failed validation error displayed for search results

After searching for and attempting to download a package containing an unaccepted EULA, the 
expected message “Some of the selected packages failed validation...” is displayed on the Download 
Packages window. However, if you then search for a package that does not contain an EULA (but do 
not attempt to download the package), you received the “failed validation” message instead of the 
correct message describing the filter results: “Results for Download package name: <name>”.

Pagination control fields not showing correct information

The pagination control fields on the Download Packages window are not displaying the correct totals 
for a filtered list of packages.

Inappropriate message displayed for already downloaded packages

When you select an entitlement line item whose packages have already been downloaded, the 
Download Packages window is displayed with the incorrect message “Files sent for download. Please 
monitor the download manager pop up”. The message should be removed altogether or displayed only 
as package files are being sent to the Download Manager (before the actual Download Manager 
window is displayed).

SWM-7952: Not all applicable download links available on List Downloads 
page in End-User Portal
When end-users are logged in with an activation ID for an entitlement line item that is associated with 
multiple products, the Downloads page (accessed from Downloads > List Downloads) in the End-User 
Portal does not always show links to all applicable product downloads.

SWM-7786: SHA2 Checksum value of previous file shown
If a user has provided a file’s expected SHA2 checksum value for an upload and the file image is 
subsequently deleted, the Upload File page, when opened again, might show the SHA2 checksum 
value of the previously loaded file image.
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SWM-6996: Updating device “Site name” property to blank not handled 
properly
If you change the Site name value for a device to a blank, the edited property reverts to its original 
value instead of maintaining the blank. This issue occurs when you make the change either through 
the Devices UI in the Producer Portal or End-User Portal or through the updateDevice method in the 
ManageDeviceService SOAP web service. 

SWM-5894: Changes and limitations to the updateDevice SOAP method
The updateDevice method in the V3 and V4 ManageDeviceService SOAP web service has the following 
limitations and changes:

• Single channel partner recommended in channel partner list

• Support for only Replace operation in channel partner list

Single channel partner recommended in channel partner list

As in previous releases, the updateDevice method supports a list of channel partners. However, 
because a device is currently limited to one channel partner, the web service code, in turn, considers 
only one channel partner for the method. Therefore, you are strongly recommended to include only one 
partner in the channel partner list. If the list contains more than one channel partner, the behavior of 
updateDevice method is unpredictable. 

Support for only Replace operation in channel partner list

Previously, the opType element, required for managing a channel partner list for the updateDevice 
method, had three possible values: Add, Delete, or Replace. This element now supports only the 
Replace value. If you specify Add, Delete, or Replace or omit the element altogether, the method will 
always use Replace. (If you attempt to specify Add or Delete, a message is returned in the response, 
explaining that Replace was used instead.)  

FNO-65909: Download files not visible for self-registered and trial users
Download files might not be visible in the End-User Portal for self-registered users and those users 
registered through the “Try Before You Buy” registration. 

FNO-63827: Downloads sometimes not available to end users when 
accounts are re-identified
When a new account is set up with an account ID previously used by a different account, and a user 
who belonged to the original account is assigned to the new account, that user is unable to see 
Software Delivery download links in the End-User Portal. 

FNO-61266: Translation issues with localization
Per a previous enhancement in 2020 R3 to add more language support for End-User Portal 
localization, certain strings—such as alerts and validation messages—are not being translated 
properly when localization is in effect. These issues will be addressed in an upcoming release. 
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FNO-60845: Size limitation for license models
The JSON definition of a license model and the definition’s internal representation are both stored in 
the FlexNet Operations database. Neither the JSON definition nor its internal representation can 
exceed 8000 bytes in length.
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Special Notes
This section contains special information pertaining to FlexNet Operations.

Plug-in Upgrade Needed for High-Speed File Uploads
If you intend to use the high-speed upload option to upload files, upgrade the Aspera plug-in to Aspera 
Connect 3.10.0 or later. 

Best Practice for Uploading New File Versions for Software Delivery
The following practice helps to prevent the delivery of “stale” file content to your customers.

When you upload a new version of a file (or package) whose previous version exists in the Software 
Delivery system, best practice is to give the new file version a unique name, different from the name of 
the existing file version. (For example, use a version number in the file name.) Try to avoid uploading a 
file using the same name as the existing file so that the existing file is overwritten. 

If you must upload a new file using the same name as the existing file, delete the existing file and wait 
10-15 minutes before uploading the new version. This process will reduce the probability of re-
caching the old content.

Handling UI Conflicts When Using a Custom CSS for the End-User Portal
When you use your own CSS to customize the look of the End-User Portal, sometimes your custom CSS 
code conflicts with existing Revenera CSS code that is used to define certain buttons, pages, and other 
UI elements. When conflicts occur, handle each case individually, determining the basis of the conflict 
and adjusting the custom CSS as needed. If you require assistance, contact Revenera Technical 
Support (see Revenera Resources).
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Legal Information
Copyright Notice
Copyright © 2022 Flexera Software

This publication contains proprietary and confidential information and creative works owned by 
Flexera Software and its licensors, if any. Any use, copying, publication, distribution, display, 
modification, or transmission of such publication in whole or in part in any form or by any means 
without the prior express written permission of Flexera Software is strictly prohibited. Except where 
expressly provided by Flexera Software in writing, possession of this publication shall not be construed 
to confer any license or rights under any Flexera Software intellectual property rights, whether by 
estoppel, implication, or otherwise.

All copies of the technology and related information, if allowed by Flexera Software, must display this 
notice of copyright and ownership in full.

FlexNet Operations incorporates software developed by others and redistributed according to license 
agreements. Copyright notices and licenses for these external libraries are provided in a 
supplementary document that accompanies this one.

Intellectual Property
For a list of trademarks and patents that are owned by Flexera Software, see https://
www.revenera.com/legal/intellectual-property.html. All other brand and product names mentioned in 
Flexera Software products, product documentation, and marketing materials are the trademarks and 
registered trademarks of their respective owners.

Restricted Rights Legend
The Software is commercial computer software. If the user or licensee of the Software is an agency, 
department, or other entity of the United States Government, the use, duplication, reproduction, 
release, modification, disclosure, or transfer of the Software, or any related documentation of any kind, 
including technical data and manuals, is restricted by a license agreement or by the terms of this 
Agreement in accordance with Federal Acquisition Regulation 12.212 for civilian purposes and 
Defense Federal Acquisition Regulation Supplement 227.7202 for military purposes. The Software was 
developed fully at private expense. All other use is prohibited.

https://www.revenera.com/legal/intellectual-property.html
https://www.revenera.com/legal/intellectual-property.html
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